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1 INTRODUCAO

O Plano Estratégico 2008-2012 (PEST 2008-2012) do Sistema Estatistico Naciona (SEN)
(Anexo 1), aprovado pelo Conselho Superior de Estatistica contempla, como uma das suas
actividades prioritérias para 0 ano de 2009, a realizacdo do Il Censo Agro-Pecué&rio (CAP
2009-2010). A recolha de dados do CAP seré redlizada de Dezembro de 2009 a Setembro
de 2010. Nele serdo realizadas duas operagdes principais, nomeadamente entrevista geral dos
maodulos complementares (adicionais) e a medicdo de areas a cerca de 20% dos agregados
familiares com machambas, nas &reas de enumeracéo seleccionadas. Estas operagdes seréo
efectuadas em simultaneo, conforme o calendério definido, sendo de Dezembro de 2009 a
Abril de 2010 (12 fase) e de Maio a Agosto de 2010 (22 fase) para a zona Sul e de Abril a
Agosto de 2010 para a zona Centro e de Maio a Setembro de 2010, para a zona Norte do
Pais.

A redlizacdo do CAP 2009-2010 enquadra-se também nas recomendacdes da FAO, entidade
do Sistema das Nagdes Unidas coordenadora das estatisticas agricolas. O processo do CAP
seguiraa METODOL OGIA MODULAR (FAO,WCA 2010) (vide figura no anexo Il), que
consiste em i) uso dos dados do |11 Recenseamento Geral da Populacédo e Habitagdo 2007 (111
RGPH), como Médulo Comum e base de amostragem (Seccdo G), sendo exaustivo e
representativo ao nivel da &ea de enumeracdo (aldeia) e ii) definicdo de Modulos
Complementares, para 0s quais sera desenhada uma amostra usando como base de
amostragem a informagdo relativa ao nimero de agregados familiares com exploracdes
agricolas obtida a partir do |1l RGPH, com uma representatividade ao nivel distrital, depois
da expanséo dos dados das amostras.

O CAP i) é o demento central do Sistema Nacional de Estatisticas Agricolas e do Sector
Rural no SEN, ii) providenciard informacdo estatistica chave para os programas do Governo
designadamente para o alivio da pobreza e o desenvolvimento da seguranca alimentar, 0s
objectivos primérios do Programa Alargado de Reducdo da Pobreza Absoluta (PARPA 1) e
Objectivos do Desenvolvimento do Milénio (ODM) e ii) € o projecto estratégico do PEST
2008-2012 do SEN/INE.

O | Censo Agro-Pecuério (CAP 1999-2000) de Mocambique no periodo pés-independéncia
foi realizado, entre Setembro de 2000 e Julho de 2001, pelo Instituto Nacional de Estatistica
(INE) em parceria com o Ministério da Agricultura (entdo Ministério da Agricultura e
Desenvolvimento Rural, MADER). Ao contrario do CAP 2009-2010, aquele seguiu 0 método
tradicional (WCA 2000), isto é, ndo modular, de desenho da amostra com base nos dados do
Il RGPH 1997 e com question&rio extensivo arrolando todas as questbes num Unico
formulario, conforme o tamanho das exploracdes. A esta operacao seguiu-se arealizacdo de 6
inquéritos agricolas anuais (TIAS), pelo Ministério da Agricultura (MINAG), o Inquérito aos
Agregados Familiares (IAF) e o Il RGPH, entre outros. Estas operagdes constituem a base
para a realizacdo com sucesso, do CAP 2009-2010 pelo INE, em estreita parceria com 0
MINAG.

Em conformidade com a lei “ compete ao INE realizar a actividade estatistica oficial do
Pais’ (8 2 art. 19 lei 7/96) na qual se enquadra a realizacdo do CAP. Ao Ministério da
Agricultura cabe um importante papel designadamente, o de actuar em parceria e apoio ao
INE, de modo a que se tirem vantagens da utilizac&o da experiéncia e dos recursos humanos,

Censo Agro-Pecuério 2009 — 2010 6



Manual de Cartografia

materiais e financeiros existentes nas duas institui¢cdes. Cabe igualmente um papel especia ao
Ministério das Pescas, como 6rgédo regulador do sector pesgueiro, componente integrada no
1l RGPH (seccéo de aquacultura) e no CAP. Espera-se desta instituicdo a alocagéo de
recursos materiais e humanos para o bom andamento das actividades do CAP.

O CAP sera realizado em todos os distritos do Pais e abarcara a campanha agricola 2009-
2010 pelo que a operacdo do Censo prolongar-se-a até ao final do 3° trimestre do ano de
2010. O CAP actuaizara a informacéo de natureza estrutural bem como proporcionard uma
nova base de amostragem para 0s inquéritos infra-anuais, de que se destacam os TIAs
realizados pelo MINAG e os inquéritos da pesca artesana realizados pelo Ministério de
Pescas (MP).

A realizacdo do CAP compreende um periodo de preparacdo. As actividades preparatérias
iniciaram-se no Il semestre de 2008. Elas incluem, entre outras, a elaboracdo do Plano
Director, do plano metodoldgico, plano operativo, a criacdo das Comissdes ao nivel central,
provincial e distrital, acontratacdo da assisténcia técnica, a capacitacéo do pessoa de gestdo
e supervisdo do CAP, a aquisicdo de equipamento e meios de trabalho e de transporte, o
recrutamento do pessoal necess&rio para as operacdes de recolha de dados no campo, a
capacitacdo do pessoal de implementacdo do Censo a todos os niveis, a realizacdo do Censo
Piloto, a consulta com os potenciais utilizadores, a elaboracdo dos questionérios, dos planos
de tabulacdo, dos manuais e de outros documentos metodol 6gicos, a publicitacdo censitéria e
mobilizacdo das estruturas e comunidades locais.

Dentro das actividades preparatérias destaca-se a realizacdo do Censo Piloto, que decorreu
em trés provincias do Pais, nomeadamente Gaza, Maputo e Cidade de Maputo, abarcando
zonas rurais e urbanas. Assim, no Censo Piloto foram inquiridas pegquenas, médias e grandes
exploragdes, |ocalizadas nas zonas seleccionadas.

A experiéncia do CAP 1999-2000 e outras em matéria censitaria e inquéritos do INE e de
inquéritos agro-pecuérios do MINAG acima referidos constituem, sem divida, premissas
para 0 estabelecimento de metodologias e procedimentos solidos, em linha com as
recomendacdes de organismos internacionais especializados em estatisticas agro-pecuérias,
de que se destacaa FAO.

Este Plano Director constitui um documento guia para a execugcdo do CAP no ambito do
Plano Estratégico, contendo os objectivos, os principios basicos, as caracteristicas técnicas e
as actividades que o compdem. Contém também o cronograma das actividades e as linhas
gerais do orcamento requerido para a implementacdo dentro dos prazos, das actividades
planificadas, 0 que garante o desenvolvimento harmonioso, oportuno e adequado em cada
uma das etapas que compdem este Censo.

2 PRINCIPAISINTERVENIENTES
O CAP 2009-2010 é uma operacdo estatistica de grande envergadura que envolvera muitos

actores eintervenientes. O sucesso do CAP dependera, em grande medida, do envolvimento e
participacdo activa e consciente da populagdo, dos agentes econdmicos, das autoridades do
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Governo e do Estado, das entidades locais, das associacfes de produtores e dos proprios
produtores, utilizadores, fornecedores, e produtores dos dados.

Foram realizados varios encontros de consulta com 0s principais actores e intervenientes,
nomeadamente, técnicos e pesquisadores de areas relevantes, académicos, representantes das
ONG’s, associagOes, sector privado, entre outros, com vista a se discutirem os objectivos do
CAP, necessidades de informagdo, conceitos e definicbes, bem como sobre o préprio
contetido e o questionario.

E necessario potenciar a participaco livre e espontanea de todos. Contudo, ha que observar a
lel, podendo, como Ultimo recurso, aplicar-se san¢fes (multas) salvaguardando o principio de
autoridade estatistica.

Deve ser assegurada a cooperacdo técnica e financeira dos parceiros de cooperacéo, para
apoio a execucdo do CAP, destacando-se o papel da FAO como lider de assisténcia técnica
internacional, nas estatisticas agricolas no Sistema das Nagdes Unidas.

O governo tem ja garantido os recursos humanos necessérios, desde o nivel central até ao
distrital, bem como as infra-estruturas fisicas e outros meios para aimplementacdo do Censo.

O INE encontra-se a trabalhar em estreita parceria com o Ministério da Agricultura
(MINAG). Serdo envolvidos outros utilizadores bem como fornecedores de informagéo,
nomeadamente o0 Ministério das Pescas (MP), o Ministério da Administracéo Estatal (MAE),
0 Ministério da Industria e Comércio (MIC), o Ministério da Planificacgo e Desenvolvimento
(MPD), Universidades, Associacdes de produtores agricolas, entre outros.

3 DEFINICAO, IMPORTANCIA E OBJECTIVOS
3.1 Definicéo eimportancia

O Censo Agro-Pecu&rio é uma operacdo estatistica para a recolha, processamento e
disseminacdo dos dados do sector agrério. O CAP fornecera dados de referéncia na base dos
quais se pode fazer o juizo do sucesso das politicas e programas de desenvolvimento do
Governo e diagnosticar os constrangimentos existentes no sector agrario. Os resultados do
Censo permitirdo monitorar de forma mais eficiente os Objectivos de Desenvolvimento de
Milénio (ODM) e permitirdo ao sector privado, incluindo os produtores agro-pecuarios,
tomarem as suas decisdes empresariais.

A importancia do CAP é acrescida considerando-se que o pais é fundamentalmente agricola e
a constituicdo da Republica consagra a agricultura como base do desenvolvimento. Cerca de
75 % da popul agdo tem na agricultura e pecuéria a sua fonte de rendimento.

3.2 Objectivos gerais
O objectivo geral do CAP é obter informacdo estatistica actualizada sobre a estrutura agro-

pecuaria, bem como sobre a producdo, para um melhor conhecimento da realidade. Esta
informac&o é necesséria para a elaboracéo, acompanhamento e avaliagéo de politicas e planos
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de desenvolvimento que concorram para a melhoria das condic¢des de vida da populagéo, para
o alivio da pobreza e investigacdo com destaque para a Revolucdo Verde e Objectivos de
Desenvolvimento do Milénio (ODM).

3.3 Objectivos especificos

> Conhecer a estrutura do sector agro-pecuério designadamente, o nimero de unidades
agro-pecudrias, tipo, distribuicdo espacial, tipo de propriedade, uso e aproveitamento
da terra, posse e uso de meios de producdo e tecnologia empregue, aos niveis
nacional, provincial e distrital;

» Conhecer a producdo e produtividade das principais culturas agricolas e espécies
pecuarias;

> Produzir bases de amostragem para a realizacdo de inquéritos para a recolha de dados
sobre variaveis dindmicas ndo cobertas pelo censo, melhorar a producdo de
estatisticas correntes e contribuir para a producdo de um sistema integrado de
estatisticas agro-pecuérias,

> Obter informagao béasica para a monitoria e avaliacdo de planos de desenvolvimento
do sector agro-pecuério de que se destaca o Programa Nacional de Desenvolvimento
Agré&rio (PROAGRI), nasuafasell;

> Obter uma base de dados actualizada sob perspectiva do género, ambiente, econémica
e socio-demografica do sector agrério;

» Obter uma base de dados que permita avaliar as mudancgas estruturais ocorridas no
Pais ao longo dos ultimos 10 anos.

Os objectivos especificos do CAP 2009-2010 enquadram-se nos objectivos estratégicos
especificos definidos no Plano Estratégico do SEN 2008-2012 e aprovados pelo Conselho
Superior de Estatistica (CSE), nomeadamente nos Objectivos Estratégicos Especificos 1.3,
15,22,31,32e4.1.

4 RESULTADOSESPERADOS

Os resultados esperados do CAP 2009-2010 derivam dos objectivos estratégicos especificos
referidos no ponto anterior e S0 0s seguintes:

Resultados esper ados:

Elaboradas e disseminadas as publicacbes de dados preliminares e definitivos ao nivel
nacional;

Elaborada e disseminada a publicacdo de dados definitivos ao nivel provincial;
Elaborada e disseminada a publicacéo de estudos tematicos;

Realizados trés “workshops’ centrais, para a disseminagéo de dados, sendo um para
divulgacdo de dados preliminares, outro para divulgagdo de dados definitivos e o
ultimo para divulgacéo dos estudos teméticos;
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Redlizados encontros com o0s parceiros e com 0s principais utilizadores da
informagao;

Realizadas campanhas de sensibilizacéo;

Produzidas e disseminadas estatisticas com desagregacao provincia e distrital;
Produzida a base de dados estatisticos;

Actualizados os mapas cartogréficos parao CAP e inquéritos posteriores;

Realizada a recolha de dados através de entrevista directa assistida por computador
(CAPI - Computer Assisted Personnel Interview);

Concluida a recolha de dados através de método modular, de acordo com as
recomendacdes;

Actualizada a base de conceitos e definicfes, na &rea da agricultura, para utilizagdo
por todos os Orgdos produtores de estatistica, nomeadamente ao nivel do Sistema
Estatistico Nacional;

Aumentada a capacidade técnica de gestdo e implementacdo de Censos da Agricultura
dos funcionarios do Instituto Nacional de Estatistica e do Ministério da Agricultura,
bem como dos seus servigos desconcentrados.
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5 CARTOGRAFIA DO CENSO AGRO-PECUARIO 2009-2010

A base cartografica do censo da populacdo e habitacdo 2007 criou areas

de enumeracdo com caracteristicas geograficas, demogréficas e sbcio-
-

econémicas. A necessidade de cada vez mais compreender a estrutura
socio-econdmica e produtiva dessas entidades espaciais (AE) vincula a continuacdo da
recolha de dados na mesma AE, o que vai permitir ndo so ligar a base econémica produtiva
das unidades agro-pecuarias com a sua informacéo demografica, social, étnica mas também
fornecer a estrutura da seguranca alimentar das familias e com isso ajudar a monitorar as
metas dos objectivos de desenvolvimento do milénio.

Com a CARTOGRAFIA do CENSO AGRO-PECUARIO espera-se que todas as AE sgjam
localizadas e actualizadas no campo; as exploracdes agro-pecuarias sgjam identificadas e
mapeadas; os mapas de localizagéo e distribuicao das exploracfes agro-pecuarias sirvam
como base para ajudar na tomada de decisdo em: onde produzr, o que produzir e que
constrangimentos estariam por detras da base produtiva agro-pecuéria.

Além disso, o0 préprio processo cartografico é uma ferramenta de documentacéo

metodol 6gica do CENSO AGRO-PECUARIO.
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5.1 OBJECTIVOS DA CARTOGRAFIA

a) ldentificar os limites da Area de Enumerago seleccionada
b) Dividir a Areade Enumerag&o seleccionada pelos 3 inquiridores

¢) Registar alocalizagéo da exploracéo

e) Transferir os dados do GPS para o computador

f) Monitorar aqualidade de dados do GPS

d) Medir aareae o perimetro de todas as machambas cultivadas dos 2 AF seleccionados

Censo Agro-Pecuério 2009 — 2010
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5.2 RESUMO DOSPROCEDIMENTOS CARTOGRAFICOS DO
INQUIRIDOR

1- Pedir o mapa da Area de Enumeracio-AE ao controlador. O mapa da AE
constitui a area de trabalho
Interpretar 0 mapa da AE, incluindo a identificacdo geogréfica. Serve para saber em
que Distrito, Posto Administrativo, Localidade, Aldeia, Bairro, Zona, Célula, ou
Quarteirdo onde vai trabalhar.
Utilizar os cddigos de identificacdo geogréfica da AE para preencher a Seccdo A da
entrevista
Introduzir os pontos de controle da Area de Enumeracio no GPS e navegar o limite da
AE
Registar a localizacdo geografica das exploragdes, machambas e tanques de
aquacultura
Medir a &rea e 0 perimetro de todas as machambas cultivadas dos 2 agregados

familiares seleccionados
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5.3 ELEMENTOS DO MAPA DA AREA DE ENUM ERAC;AO
.. Objectivo
o Familiarzar-se com os elementos geogréficos do mapa para melhor entender a &rea
"= detrabalho mesmo sem ter visitado-a anteriormente
Correlacionar 0s objectos presentes no mapa agueles do terreno
Compreender a divisdo administrativa da &rea de trabalho e com isso preencher efectivamente
aidentificacéo e alocalizagdo da exploragéo

@ Metodologia

== Interpretac&o visual do mapa da é&rea de enumeracdo
Correlagéo espacial
Orientacdo geogréfica

Procedimentos
5.3.1.Identificacéo geogr &fica
a Integrar a AE na unidade administrativa correspondente, interpretando a caixa de
IDENTIFICACAO GEOGRAFICA.
b) Vigar até a area de trabalho com base na hierarquia administrativa presente na caixa

de IDENTIFICACAO GEOGRAFICA
Eis a hierarquia administrativa actual :

(v) Localidade

(vi) Bairro

(vi) Povoacio/Aldeia
Cutras divizdes

Presidente da Localidads
Secretdrio do Bairro
Chefe da Povoagio/ Aldeia

Divisio Administrativa Autoridade IDENTIFICACAO GEOGRAFICA
Al. PROVINCIA: MAPUTO 10

(I) Provincia Governador da Provincia A2 DISTRITO: BOANE 02
(i) Distrito Adminiztrador do Distrito

. . A3. P. ADMIN: BOANE o1
(1) Posto Administrativo Chefe do Posto

. L . S A4. AREA RURAL - 2 X
(iv) Mmnicipic Preszidente do Monicipie
- A5. Localidade: Gueguegue 02

A7. N° da Area de Enumera(;éo

A10. Nome da Povoagédo
Chipava 09

All. Nome da Zona/Bairro 99

¢) Retirar dacaixade | DENTIFICACAO GEOGRAFICA, os codigos geogréficos da

sua érea de traba ho

d) Preencher a Secgdo A (ldentificagdo e Localizagdo da Exploragéo) do CAPI com base
nos codigos geogréficos retirados da IDENTIFICACAO GEOGRAFICA daAE

€) No campo GPS do CAPI introduzir o nimero de 3 digitos que obteve a partir do GPS
aquando do processo de listagem

f) No Easting e Northing preencher as coordenadas de

localizagdo do AF obtidos durante alistagem

i Easting

Morthing

Censo Agro-Pecuério 2009 — 2010
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Simbola Significada Simbolo Significada
532 L egenda N Limite da Localidace ; Relevo
. Casas Referéncia
a) Observar atentamente acaixadalegenda | ===+ | "m=eme | 2 Eesbocinnts deEnsno
b) I dentl fl Car O S mbOI O da érea de — Limite da AC : igﬁiamério,’Fum
X H el Igre

enumeragéo na caixa e procurar 0 Mesmo | ---- | e i o

S mbOI O no mapa e i Outros Elementos
c) Verificar os objectos do mapa que Estabelsciento Comercise

demarcam claramente o limite da area de . Pantas de controle

enumeragao
d) Identificar, usando alegenda, os outros objectos de referéncia presentes no mapa
€) Obeservar aordem e disposi¢cdo dos pontos de controle

5.3.3. Escala

a) Posicionar a régua ou linha flexivel na unidade de
medi¢ao presente na escala, exemplo: 0 a 100 metros

b) Retirar a mesma distancia unitéria e posicionala de um
ponto de controle ao outro

c) Multiplicar o nimero de vezes que a unidade coube pela
distancia da escala, por exemplo: 2x100= 200 metros

d) Ficar a saber que de um ponto de controle ao outro a
disténcia é de, por exemplo, 200 metros

€) Dividir adistanciatotal (ex: 200 m) pelo seu passo médio (ex: 1m por segundo) para
conhecer 0 tempo médio para percorrer adistanciaem causa

f) Paraeste nosso exemplo vao ser necessérios 3.3 minutos para percorrer a distncia de
200 metros

g) Ficar ater nogdo sobre o tamanho da AE e o tempo necessario para fazer alistagem.

5.3.4. Norte geogr fico P‘ W o A
a) Questionar 0 seu guiaonde équegeramentenasceosol | ';":F o B

b) Virar asua cabeca olhando para o Este (sentido onde nasce " < i

0 sol) (e

c) Esticar o seu braco esquerdo e ficar a saber que esse € 0 = Fﬁ

seu norte geografico

d) Virar o mapa no sentido da grelha (linhas verticais e horizontais perpendiculares e
espacadas regularmente) estar orientada para o norte

€) Entender os objectos ao seu redor (usar alegenda)

5.3.5. Background

Constitui ainformagao adicional do mapada AE e contém arepresentacdo simbélica dos
objectos presentes no terreno. Eles podem ser fisico-natural (ex: relevo, rios, vegetagao)
socio-econémicos (aldeias, vias de acesso, igrejas), etc. j N !

5.3.5.1 Mapas topogr &ficos

a) Paraentender os objectos ao seu redor veja o seguinte:
al. os pequenos pontos dispersos ou concentrados, °
representam os assentamentos humanos rurais e |
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urbanos, respectivamente

a.2. as grandes formas regularmente espacadas representam infra-estruturas

a.3. a tonaidade verde representa a vegetacdo, a azul-fontes de &gua, cinza ou

vermel ha-areas densamente povoadas

a4. as linhas castanhas (ou cinzas) representam curvas de nivel, as linhas vermelhas -
vias de acesso, linhas escuras interrompidas-linhas férreas, linhas escuras continuas-limites
administrativos

a.5. as bolinhas a rosa representam os pontos de controle. S&0 os pontos de controle
gue quando unidos formam o limite da &rea de enumeracao.

5.3.5.2 Imagens de satélite

As AE das zonas urbanas (vilas, municipios, cidades) possuem o
"fundo" baseado em imagens de satélite. A imagem de satélite
foi usada para captar o maior detalhe de informacéo das areas
densamente povoadas.

a) Utilizar a seguinte chave para entender os objectos da
imagem de satélite:

Elementos basicos na imagem ou fotogr afia
Objectos ou Tonalidade | Forma Tamanho | Densidade | Posicao
elementos
A-Assentamento rural | Brancae preta rectangular pequeno ata rural
B-Agricultura Verde e castanha | quadrangular | maior menor rural
empresarial
(monocultura)
C-Rio Brancaeescura | irregular - - -

5.3.5.3 Dados no for mato vector

a) o formato linear representa vias de acesso

b) o formato regular, muito bem organizado, com estruturas
lineares de vias de acesso, representa assentamentos
urbanos organizados

c¢) Os nimeros em circunferéncias representam cédigo da area
de enumeracéo
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5.4. IDENTIFICACAO DOSLIMITESDASAREASDE ENUMERACAO

Objectivo

A identificagéo dos limites da AE tem como objectivo garantir que as actividades do
~* Censo Agro-pecuario decorram no espago geogréfico seleccionado, evitando que
hajam enganos de omisséo ou de duplicacgo na recolha de dados. O processo de identificacéo

dos limites da AE passa por navegar a rota. Navegar a rota serve para visualizar, no GPS, o
limite da AE.

O Metodologia )
Inserir e unir os pontos de controle para formar a rota (limite da Area de
Enumerac&o)
Navegar arota

Procedimentos

& a) Do mapa da Area de Enumeracdo retirar os pontos de controle e inserir-os
[% no GPS
|Num Easting I arthinig

009 001 434116.39| 713646538
Q09 oz 433544 .73 7136836 19
002 003 432950 76 7137345 51
0097004 437246 25| 7136240 31
0097005 431071 60| 7134462 97
009 oos 431803.02 | 7134214 75
009 o7 431962 58] 7134064 07
003 o0 43198917 [T133439.12
009003 432667 .51 [ T133634 .14
008 010 432591 96| 7133675 45
009011 435276 96| 7135045 03

T T
numero da AE Pontoe de controle

5.4.1. Inserir ospontos de controle no GPS
a) Marcar uma coordenadaficticia
a.l. Paramarcar a coordenadaficticia passa por ligar o

GPS usando o botdo POWER

NOTA.: pressionar Menu- uma vez e escolher a opgéo use GPS off para ndo gastar a pilha

a.2. Navegar até a pagina de satélites [pode usar PAGE -ou ENTER-]

a.3. Pessionar demoradamente o ENTER e aterar 0 nimero para comegar com 0
codigo da AE seguido do ponto de controle (ex:009001). Serve para diferenciar os
pontos de controle duma AE da outra.

b) Descer com 0 ROCK ER- parabaixo até LOCATION e pressionar ENTER
C) Seguir com a seta ? para direita pressionando no ENTER (a medida que vai
rolando a seta 0s nimeros ficam iluminados a amarel o)
d) Para encontrar o nimero/letra que desgja introduzir, sobe ? , desce? , esquerda ? |,
direita? (usando o ROCKER) até encontrar o alvo e seleccionar Ok com ENTER.
e) ROCKER ? paraOK e pressionar ENTER
f) ROCKER ? epressionar ENTER.
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5.4.2. Unir os pontos de controle paraformar o limite da Area de Enumeragéo
a) Pressionar 2 vezesMenu parater acesso ao Menu Principal

=

b) Seleccionar Routes &t
b.1. ROCKER? atéroutes >ENTER
C) 0 new vai aparecer seleccionado a amarelo. Pressionar ENTER —>Select Next Point
—2ENTER - Waypoints > ENTER - ENTER - Use > Select Next Point (agui trata-se
do segundo ponto darota) = Select Next Point (trata-se do 3 ponto darota), até terminar.

0 NOTA: uma rota compl eta comeca e termina no mesmo ponto

5.4.3. Navegac&o e vizualizag&o do limite da Area de Enumer agio

5.4.3.1. Navegacao do limiteda AE

a) 2 Menu> ROCKER ? ->Routes > ENTER-> ROCKER ? - ENTER-> ENTER (
para seleccionar a op¢ao Navigate)

5.4.3.1.Visualizagdo do limiteda AE

a) 2 Menu> ROCKER ? >Routes > ENTER—> ROCKER ? - ENTER-> ROCKER ?
—ENTER (para seleccionar a opcdo Map)

b) Movimentar o ROCKER ? ? ? ? até centralizar todo o limite da AE usando o cursor
branco

C) Zoom in ou Zoom out paraampliar ou reduzir o limite da AE, respectivamente.

5.4.3.2. Desactivar avisualizagéo do limiteda AE no GPS

a) 2 Menu»> ROCKER ? ->Routes > ENTER-> ROCKER ? - ENTER->
ENTER (para seleccionar a opgéo Stop).

Censo Agro-Pecuério 2009 — 2010 18



Manual de Cartografia

5.5. LOCALIZACAO DA EXPLORACAO E MEDICAO DA AREA E
PERIMETRO DA MACHAMBA

Objectivo

Visa conhecer alocalizagéo e distribuicdo das exploracdes agro-pecuérias no
~*" territério nacional e estimar com precisao a porcao daterra explorada parafins
agricolas bem como compreender a distribuicdo territorial dessas unidades produtivas.

Metodologia
@ Marcar os pontos usando ENTER

Localizar os pontos usando GoT o
Gravar o limite da machamba cultivada com base no Track
Calcular a érea e o perimetro da machamba com base no ar ea calculation

I‘;aP Procedimentos

5.5.1. Localizacdo da exploragdo

5.5.1.1. Certificar se esta dentro da AE selecionada

a) Navegar até a paginado mapa do GPS

a.l. Clicar 2 vezes no botéo Page

b) Verificar se a seta preta do GPS (sua posicao actual)
encontra-se dentro dos limites da AE. Mantenha o GPS na

paginado mapa.

5.5.1.2.Marcar alocalizagdo da exploracéo

a) Com Quit navegar até a pagina dos satélites e confirmar se 0
GPStem a 3D e+3 a5 metros de acuracia

b) Na entrada da casa do AF, pressionar sem largar a tecla
ENTER até aparecer ajanelaMark Waypoint

¢) Registar as coordenadas nafichade listagem

€) Pressionar de novo ENTER para gravar a coordenada com
OK

empresa, tanque de aquacultura, machamba. Para o caso da
empresa e machamba a coordenada tira-se no meio da exploracéo
a0 passo que para o tanque de aquaculturaéa 1 m.

. NOTA: esta instrucéo é valida para marcar a localizacdo do AF,

5.5.1.3. Visitar a exploracdo parafazer a entrevista

a) Caso tenha a coordenada no seu GPS

a.l. Pressionar o boté&o

FIND->Waypoints> ENTER-> (ROCKER? até aexploracdo
gue foi seleccionada paraaentrevista> ENTER-> GO To

a.2. Seguir arota que o GPS va |he exibir na pagina do mapa
ou acompanhar a direcdo mostrada pela blssula

b) Caso néo tenha a coordenadano GPS siga 0s passos5.3.1. €5.4.1.3. a).
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NOTA: a coordenada da exploracao a entrevistar € lhe

fornecida pelo controlador. N&o esquega registe-na!

5.5.2. Medicdo da area e perimetro da machamba

5.5.2.1. Delimitar a machamba a partir do track
a) Pressionar 2 vezes M enu para abrir o Menu principal

&
b) Pressionar ENTER para seleccionar Track EﬁEiJ
d) ROCKER? ? eseleccionar Setup pressionando o ENTER
€) 4 vezes ROCKER ? eno Data Card Setup, pressionar ENTER->ENTER Track (limite da
paraactivar Log Track To Data Card, permitindo gravar o maior nimero machamba)
de tracks (limite da machamba).
f) 2 vezes Quit paravoltar
g) ROCKER ? seguido de ENTER->ENTER para

activar Track Log On e comegar a gravar o limite  ,_._. e 2| wome
da machamba da mochamba Disterice da frack
}***% 2.67m _
oo fﬁu'ea da
NOTA: Quando o track estiver pronto para marcar o lo.5010 m? =" machamba
limite da machamba, a percentagem vai passar de 0% Cor do ’*—EW
para 1% e nunca remover o cartdo do GPS track [ Snow an Wep
h) Quit até encontrar a Pagina dos Satélites | Delete | Mop
i) Quando o GPS estiver na acurécia de +3 a 5 | TrocBack | OK

metros, marcar 0 ponto de partida, seguido de
pontos intermédios que indicam os diferentes contornos da machamba, até marcar o ponto
final ou de fecho

A NOTA: Deve garantir que o seu ponto de partida coincida com o seu ponto de chegada. E
imperioso memorizar os pontos de partida e chegada da machamba de medicdo actual.

J) Seleccionar o Track L og Off quando terminar o track da machamba para o GPS néo
gravar movimentos ndo necessarios. Mantenha-se no Menu Track.

5.5.2.2. Calcular a &rea da machamba

[) 2vezesROCKER? - ROCKER ? ecom ENTER selecionar Save. Uma mensagem
val aparecer aquestionar se quer gravar entiretrack [Do you want to save the entire
track?]

m) ROCKER ? e seleccionar Nocomo ENTER

NOTA: é muito importante seleccionar o No visto que caso contrario o GPS podera somar as
A areas das machambas

0) Mover o ROCKER até o ponto de inicio do track da machamba e pressionar ENTER.

seguido de Zoom in/out. A medida que o cursor branco estiver a afastar-se do ponto, faga um
novo ROCKER até visualizar o ponto e Zoom in/out. Quando o ponto estiver visualizado, vai
aparecer o numero identificador do ponto e nesse momento pressionar no ENTER.

p) Escolher o tempo maisretardado e ENTER

.I NOTA: Paravisualizar o ponto, utilizar o ROCKER e posicionar a seta branca sobre o ponto,
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g) Repetir o mesmo processo, seleccionando o ponto de fecho da machambae o
tempo maisrecente e seleccionar OK com o ENTER

r O GPSvai automaticamente fornecer |he a area da machamba

s) 4vezesROCKER? - ENTER, no campo Area seleccionar a area em m?2

t) Multiplicar adreaem mz2 por 0.0001

u) Registar o resultado da multiplicagdo no CAPI, Seccdo C (Informagéo sobre
machambas/parcel as 2009/2010)

NOTA: caso a &rea ndo apareca automaticamente ao fazer o Save, dirija-se até o track em
causa e sobre ele pressionar Menu—> ENTER (Area Calculation) > ENTER (Sart) >ENTER

(Stop) > Save

v) Quit paravoltar ajanelade Track Log

w) ROCKER? paraseleccionar o Track em causa usando ENTER e renomear com o
nimero do AF do GPS e a ordem da machamba A, B, Cn (ex: 001A)

X) Quit>2vezesROCKER? - ENTER (track) >Map paravisualizar o limite da
machamba no mapa

5.5.3.Apagar a coordenada e o track da exploracdo

5.5.3.1. Apagar a coordenada

a) Pressonar FIND->ENTER (waypoints) > Seleccionar 0 ponto que desgja apagar
—->ENTER-> 2vezesROCKER? —>ENTER (Delete)

5.5.3.2. Apagar o track
b) 2 vezesMenu—> Tracks>ENTER-> selecionar o track que deseja apagar—-> Delete
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5.6. DIVISAO DA AREA DE ENUMERACAO PELOS 3 INQUIRIDORES

Objectivo
(22 Organizar os inquiridores na AE no sentido de evitar que hajam omissdes ou
= duplicagdes nalistagem

O Metodologia
Interpretacdo visual do mapa da &rea de enumeragédo

Reconhecimento, pelo controlador, da AE antesdeiniciar o trabalho

Procedimentos
l‘g{g a) Interpretar os objectos presentes no mapa da AE e nacaixa de identificagéo
geogréfica 2 dias antes do trabalho de campo
b) Com base naidentificacdo geogréficalevar a equipa até a AE (érea de trabaho)
c) Reconhecer, no terreno, os limites e os objectos presentes na AE
d) Dividir com base nainformagdo do mapa e ado terreno a AE em trés partes
simétricas:
c.1. usar as vias de acesso ou outras referéncias ndo confundiveis para servirem como
limite entre osinquiridores naAE
c.2. o inquiridor com maior densidade populacional tende a ter uma area pequena no
mapa
c¢.3. oinquiridor com populacéo dispersa tende ater uma area grande no mapae é
obrigado a percorrer distancias longas
c.4. extrapolar as coordenadas do mapa quando n&o forem suficientes para
caracterizar com clareza, no GPS, o limite entre doisinquiridores
€) garantir que o inquiridor tenha a sua area de trabal ho 24 horas antes da saida de campo
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5.7.TRANSFERENCIA DE DADOS DO GPSPARA O COMPUTADOR
Objectivo
Garantir 0 armazenamento e troca de dados bem como posterior controle de qualidade
e andlise espacia

Metodologia
@ Manipulaggo do DNR GARMIN baseando-se nas fungbes do Set Projection,
Download e Save File [ ONA Gami

DR Garmin

Open Garmin GPS

Procedimentos

Convert Points

@ i Calculate Shape Attributes
5.7.1. Iniciar o GPS com o computador | dedlonmer i
Calculate CEF
a) Conectar o GPS ao computador e ligar-o Chranolagy Player

Set Theme's Phota Hotlink

NOTA: o Interface do GPS deve estar na pagina do GARMIN para que o Create Phato World Files
A software conecte ao GPS

Set Moveable Images

b) clicar no DNR Garmin shortcut que esta Corf ciiipicotore
;
==

no desktop do seu computador
DNR Garmin.Ink

B MN DNR - Garmin = | =] |t
File Edit GPS Waypcoint Track FRoute Real Time Help

eTrex Yista HCx Software Yerzion 2.60 YERBMAP Americas Bec Bazemap 4.00
Lat -25.9245889Lon 32.51852081
A.It EFE | T

Connected Loading projections 0 af 1 5elected

c) Na parte esquerda inferior da janela vai : _
aparecer um sinal areferir-se do estado da  PEEARSRRIREEN

o L . .
Projaction Waypoint Track Raoute RTimelnpt

conexdo. Quando aparecer connected pode | rosc codes: © ersz - esr

H 32736 -
prosseguir. s =l
Quando aparecer Not Connected, dirijase a0 Menu | =% L
GPS>Set Port>USB UTH 2o 388 v
LT zone 36M
-LITH zone 365
UTH zone 37H
UTH zone 375
UTH zone 38M v
5.7.2. Programar o DNR GARMIN Description of Selected Projection:
<32?__SEIT11 ~
8 File-> Set Projection .
b) No POSC Code sdeccionar EPSG e | enirie: Load PRJ
introduzir o cédigo 32736 seguido de OK.
5.7.3. Descarregar e gravar pontos de localizacio da DK Concel Focet NN HNOWR
exploragdo
. 'File Edit GPS ‘Wa
a) Waypoint > Download e

Save To »

Set Projeckion
et Projection

Exit
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B MN DNR - Garmin

{

(5] |t

eTrex Vista HCx
Lat -25 924588
Alt

Connected Lo

Download

Upload

Waypoint Properties...

File Edit GP5 | Waypoint | Track Route Real Time Help

nericas Rec Basemap 4.00

0of 1 5elected

b) OK

-> Project Coordinates e siga comasinstrugdes de 5.3.2.

.‘ NOTA: Se os campos das projeccOes y_proj e x_proj ndo aparecem na tabela, vai parao Edit

c) Seleccionar File > Save To - Saveastype (text file-txt)

c.l. A janelade Save As val aparecer e deve navegar para o ficheiro da AE
criado de acordo com a identificacdo geogréfica da AE.

c.2. gravar o ficheiro com o cdédigo da AE, seguido do codigo do

inquiridor

c.3.Click Ok najanelade Save As

5.7.4. Descarregar egravar o limite, a &rea e o perimetro da machamba

a) Seleccionar Track - Download.

a.l. No canto inferior direito da janela veja a quantidade de tracks recebidos para o

descarregamento.

b) Depoisdo software completar o download, seleccionar OK

c) Seguir o ponto C de 5.6.3 paragravar os dados

NOTA: o descarregamento de dados é feito logo depois de terminar o trabalho na AE. Todo o
A trabalho dos 3 inquiridores ou mais € armazenado na mesma pasta que diz respeito a AE onde
eles trabalharam. E de inteira responsabilidade do controlador gravar na mesma pasta da AE a

ficha de listagem dos agregados familiares.
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5.8. MONITORAR A QUALIDADE DE DADOSDO GPS

Objectivo
Garantir que ndo hajam erros de omissdes ou duplicacbes

@ Metodologia
L/ Avadliagdo das fichas de listagem, controle de dados do GPS e manipulagéo do
ArcView

Procedimentos

I‘? a) Duplo clique noincone de ArcView—>Ok—>New View>Add Theme
b) Navegar até onde ainformagéo encontra-se armazenada e seleccionar o ficheiro da
AE do GPS e aguele do limite da AE.
c) Observar onde o inquiridor tenha saido paraforada AE

EFEEOE 5 [ €
] RARRICIE (] E
5"‘ . ..:’. 004
S
o.:o.: oo
d) Seleccionar os pontos que ndo pertencem a AE em causa-utilize Select

feature>Theme—>Start editing—>Delete

A NOTA: Nunca deve proceder com a seleccéo das 10 exploracdes para entrevista antes da
verificacéo da sua distribuicio

e)Abrir atabela de atributos dos pontos sel eccionando o tema>Open Theme Table

2 ArcView GIS 3.2

Cemmsor

TS| wEvrn| [ | e 2| TN s | &0l

010 597531851 3259312771} 7126996, 47086970 459272 45166710 £ 11-JUN-09 12:35:10 [3:

e [B1T " S7ei108] S oS iseurt T1443n0n | 45 s366p0ss 11U 03712 B 28 i
12 SG7RAE001 | 250315747 7126070, 47747751 459075 4804167 | 1TNUN-09 12,3549 s
013597543805 3259307625;  7126972.82677811 459267 34230036 ; 11JUN- 7:31:15. 00: 0
14 S7ssted |3 o012 | 7iosery 766373 | st o1 440de0  TION 0317 3157 w0/
015 397537150 3259305060 7126990, 24624552 459264 75223465 | 11-JUN. 7:32:01 00: 0
e 45615444 ] 32 Oo2obdb | 1258500 sy ki 8155027 050UL08 134114 5
017 3141492004 3285046840 7299826 61431641 484840.12938853 ;| 03-JUL- 2:45:08 45.00: 0

o018 o | Breacds | 30094 ssTtBs0 | 497dsa seoksss | 0L 08 13 4745 i

et 019 | Sotho0s | 8saTess| 7104 sorids7 e 20726 | UL 08 136204 i

i
1
1
i

f) O ident significa o codigo do GPS que representa a exploragéo e é o mesmo nimero que
aparece na coluna do GPS na ficha de listagem; comment é a data e hora em que foram
tirados os pontos; altitude é atopografia do terreno e sd aparece enquanto o ponto tiver sido
colectado naterceiradimensao (3D)

g) Quando a altitude for 0.00, indica que ndo foi tirado na 3D automaticamente ndo é vaido e
assim o inquiridor deve repetir o trabalho

h) Para saber onde defacto o inquiridor falhou € necessario correlacionar o numero da coluna
do GPS com 0 nome ou alcunha do responsavel pelaexploracao

i) Controlar o tempo que o inquiridor esteve atrabalhar e em repouso com base no comment

NOTA.: informar o inquiridor sempre que detectar uma anomalia
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1

2)

3)

4)
5
6)
7)

8)
9)

ANEXO 1: GESTAO DA DINAMICA OCORRIDA NASAE’S

A AE é definida como espago geografico bem definido no qual sera redizado o
recenseamento ou inquérito durante um determinado periodo e estara a cargo de um
recenseador ou inquiridor.

O tamanho da AE é estabelecido em funcdo do nimero de habitantes ou agregados
familiares. Para o caso do Censo de 2007, cada AE tera (teve) 500-750 pessoas, ou 80-
120 agregados familiares. A extensdo geogréfica e as caracteristicas fisicas podem,
algumas vezes, requerer que uma AE sga delimitada com uma populagdo acima ou
abaixo do tamanho recomendado. Em todo caso, uma AE nunca deve exceder o limite de
1000 pessoas ou 150 agregados familiares.

Antes de iniciar a elaboracéo do croquis da AE deve tracar a &rea geogréfica da escala
1:50,000 usando as distancias no terreno, estabelecendo a relacdo linear entre mapas de
diferentes escalas.

Percorrer os limites da &rea de enumeracdo priméria e marcar com |4pis as estradas e 0s
aspectos principais através de anotacdes claras.

Seleccionar os pontos de controle, principalmente nas curvas de estradas, cruzamentos, e
cartografar as suas posi¢des com a gjuda do receptor GPS.

Desenhar os limites das pequenas subdivisdes, tais como quarteirdes, zonas, células. Estes
constituiréo a base para a delimitagéo da AE.

Cartografar os outros detalhes, indicando os edificios principais, por exemplo, missoes,
igregjas, mesquitas, escolas, hospitais, lojas, casa do chefe, casa de individualidades
influentes.

Preparar alegenda dos simbolos de cada detal he que figura no mapa.

Anote os nomes dos detal hes (estradas, ruas, edificios, aspectos fisicos), etc.

10) O limite da AE coincide com os Ultimos Agregados Familiares a serem sel eccionadas.
11) Da divisdo das areas de enumeracdo, €las ficam codificadas segundo a ordem alfabética

partindo de A, B, C.

12) Quando a area de enumeracdo ndo possuir o tamanho da agregados familiares requeridos,

dirija-se @ manual de listagem.
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ANEXO 2: INTERFACE DO GPSmap 76CSx

IN/OUT Zoom Keys ROCKER

o
¢ Preciong porg cima, boixo, esquerdo ou direito
porg seleccionor pproes, entrar dodos, mover o mapo

Frecione paro novegar parg oma ou boixo
uma listo de gquolquer poging do GPS
Frecione parg fozer zoom in ou out

do pagina do mapa. Fornece detalhes-zoom in
£ omite detolhes-zoom out

FIND/MOB

Frecione porg vizuolizor o menw Find-onde
pode teracesso qos pontos grovados no GPS
Freciobe demorodomente paro ter ocesso Qo
Maon Overbord-MO8

Focilito o ocesso o5 principois pogings
do GPS. Precionondo demorodamente sem lorgar
octiva ou desactiva o bussula digital

MENU

Precionando o menu do ocesso as opooes do page
Frecionando 2 vezes o meny visualizo o menuy
principol do GP3

ENTER/MARK

Precione € lorga para mostrar opcoes seleccionadas,
dodos ou confirmar mensagens do LCD

Frecione demorodoments o guolguer momento porg
marcar @ localizocoo actual em forma de ponto

POWER

Precione demoradomente para ligar e desligor
o GFPS
Precione e lorgo ropidaments pora ojustor o luz
intemo do GPS

QUIT Key

Frecione para concelar g entrodo de dodos
ou parg soirdume poging porg outro
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ANEXO 3: Resumo das instrucgdes cartogr aficas

Inserir pontosde controle no GPS

Power - Enter - Enter demorado-> Enter no Location>introduzir as coordenadas—> Ok

Unir ospontosde controleno GPS

Precionar 2 vezes Menu—> Routes - Enter-> new - Enter - Select Next Point - Enter > Waypoints> Enter > Enter > Use

Navegar o limite da AE

2 vezes Menu~> Routes—> Enter-> seleccionar arotaem causa> Enter > Navigate> Enter

Marcar a localizagdo da pequena exploracao

Power-> esperar o GPS ter aposi¢do 3D e +3 a5 metrosde acurécia> primir sem largar atecla Enter registar a coordenada—> Enter

Visitar a exploracéo para aplicar o CAPI

Power-> Find-> Waypoints> Enter-> Rocker até a exploragdo que foi seleccionada paraaentrevista > Enter> GoTo
Para ver a exploragdo no mapa e seguir arota
2 Menu~> Map~> Enter-> Seguir arota.NB: o cursor preto representa o local onde vocé esta

Medir a area e o perimetro da machamba

Marcar o ponto dalocalizagdo da machamba

Dirijase até o centro damachamba> Power-> esperar o GPSter aposi¢éo 3D e 3 a5 metros de acuréacia> primir sem largar atecla Enter
- registar a coordenada—> Enter

Marcar otrack ou limitedamachamba

2X Menu~> seleccionar Tracks—> Track Log On.NB: se quiser sair do limite da machamba, accionar Track Log Off.

Marcar osponto de partida, intermedios e de fecho ao longo do track da machamba

Quit->Pagina dos Satélites> esperar o GPS ter aposicéo 3D e +3 a5 metros de acuracia> primir demoradamente a tecla Enter

paramarcar o ponto de partida, os pontosintermédiose o ponto de fecho

Calcular aareae o perimetro da machamba

1) 2ROCKER? - ROCKER? ecom ENTER selecionar Save. Uma mensagem vai aparecer a questionar se quer gravar entire
track [Doyou want to savetheentiretrack?]
m) ROCKER ? selecionar No como ENTER
0) Mover o ROCKER até o ponto deinicio do track da machamba e precionar ENTER.

NOTA: Paravisudizar o ponto utilizar o ROCKER e posicionar a ceta branca sobre o ponto seguido deZoom inout. A medida
que o cursor branco estiver a afastar-se do ponto faga um novo ROCKER até visualizar o ponto e Zoom infout. Quando o ponto
estiver visualizado, vai aparecer o nimero identificador do ponto e nesse momento clicar no ENTER.

y)  Escolher o tempo maisretardadoe ENTER

7)  Repetir o mesmo processo, selecionando o ponto de fecho da machamba e o tempo maisr ecente e selecionar OK com o
ENTER

aad) O GPSva automaticamente fornecer Ihe a &rea damachamba

bb) 4 ROCKER? - ENTER no Area e seleccionar a &reaem m2

cc) Multiplicar adreaem m2 por 0.0001

dd) Registar o resultado damultiplicagdo no CAPI

NOTA: caso a &rea ndo apareca automaticamente ao fazer o Save, dirijase até o track em causa e sobre ele precionar Menu->
ENTER (Area Calculation) >ENTER (Start) > ENTER (Stop) - Save

ee) Quit paravoltar ajeneladeTrack Log

ff) ROCKER? paraseleccionar o Track em causa usando ENTER e renomear com o nimero do AF do GPS e aordem da
machamba A, B, Cn (ex: 001A)

gg) Quit>2 ROCKER? - ENTER (track) > Map paravisudizar o limite da machamba no mapa

Transfererir dados do GPS para o computador

Ligar o GPS ao computador e corer o programa

->Conectar 0 GPS ao computador e ligar-o

-> Clicar no shortcut do DNR Garmin

->Menu GPS-> Set Port>USB

Atribuir projeccédo a informagéo do GPS

—>File > Set Projection

->No POSC Code seleccionar EPSG e introduzir o codigo 32736-> OK

Transferir e gravar a localizacdo da explora ¢do

->Waypoint - Download-> Ok

->Seleccionar File > Save To - Save as type (text file-txt)

- Gravar o ficheiro com o c6digo da AE, seguido do codigo do inquiridor> Ok na janela de Save As
Transferir e gravar o limite, a area e o perimetro da machamba

->Seleccionar Track > Download-> Ok

->Seleccionar File = Save To - Save as type (text file-txt)

- Gravar o ficheiro com o cédigo do Agregado Familiar, seguido da ordem alfabetica da machambar-> Ok na janela de Save As

Apagar a coordenada e o track da exploracéo

Find->waypoints—> Seleccionar o ponto que desgja apagar > Delete
2X Menu~> Tracks—> Enter-> seleccionar o track que desgja apagar > Delete .NB: ndo apagar ainformaco
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